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Holtek EIC-100 User’'s Guide

Introduction

The Holtek EIC-100 is a simple writer developed specifically for In-System Programming (ISP) of
the HOLTEK Flash range of microcontrollers.

Features

A range of useful features are included for user convenience some of which are listed below:

e Supports ESTD-100*

e Supports Flash type MCU devices

e USB interface PC communication

o Utilises USB port supply power - external power supply not required

Note ESTD-100*: HOLTEK's 8-bit Flash MCU ISP standard interface. The entire series of Flash ISP
programming equipment developed by HOLTEK utilises this standard interface.
More details are located in the "ESTD-100 user’s guide”.
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Packaging Information

e EIC-100 circuit board

e ESTD-100 interface line
e USB cable

o StarterKit.exe software

: ‘ : = USB Cable Program User's
- 0= [ ——p | ESTD-100 [W:I Target
— 1 F Board

EIC-100 Component Part Connection

Power IndicatorO O State Indicator

(Green LED) (Red LED)

usB

Interface 7-pin Data Line

Interface
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EIC-100 PC Board Structure
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System Operation

Installation

e Step 1: Connects the EIC-100 hardware as shown in the diagram

e Step 2: Install the EverPro S1000 software

e Step 3: When the setup has finished, click the "start” menu — "Holtek MCU Development
Tools” — "EverPro S1000” — "EverPro S1000”, open EIC-100 operation Windows.
See Figure 0.
The initial working window of the EIC-100 is as shown in Figure 1.
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Auto Power On

Selecting "Auto Power On” from within the "Tools”"menu will implement the auto power on MCU
function. This auto-power on feature means that after the completion of various operations, such
as download or upload, the power will be automatically supplied to the device. The MCU will begin
to operate as shown in Figure 2.
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Figure 2
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Note

Power On

Selecting "Power On” from within the "Tools” menu can supply power to the MCU. The MCU will
then operate when the power source is connected. The MCU and the procedure will then run from
its initial state. See Figure 3.

The USB interface will supply 5 V with a maximum current of up to 500 mA, which can be used to
meet the user's target board power requirements. If however this is inadequate, and more power
is required,an additional power source can be connected. It is recommended that after download,
the EIC-100 should be placed in a "Power down” state, the target board disconnected and only
then the external power source connected. In this way the possibility of damage to the target board
or the PC can be minimised.
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Power Down

Selecting "Power Down” from within the "Tools” menu will disconnect the MCU power supply. Af-
ter execution, the power supply to the MCU will be disconnected, allowing the users to modify their
target board circuits or to remove the target board. See Figure 4.
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Figure 4

Download — Program

This command is used to program the device. Before downloading, the user must have first cre-
ated an *.MTP file using the HOLTEK IDE3000 development system. If no *.MTP file exists then
the demonstration files: light.mtp , melody.mtp can be selected.The operating steps are as fol-
lows:

e Step 1: Open the file that is to be programmed into the device (*.MTP).

e Step 2: There are three options in the Download menu: "Program”, "EEData” and "ALL".
Selecting "Program” will program the Program Memory, selecting "EEData” will
program the EEPROM memory and selecting "ALL" will program both. See Figure 5.

o Step3: After the download operation has ended, "Power On” can be used to operate
the MCU.
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t48fx0e - EverPro S1000

File Edit ¥iew Upload Tools Help
= %
P EEDat ~ EEData Memory
ADDRE 0O 1 | ALL 5 5 7 ADDR 0O 1 2 3 4 5 &6 7
oooo: 1111 2222 33 BEE 0074 0065 oooo: oo oo 00 00 00 00 0o oo ...,
0o008: 0073 0074 00 Eses Progrm 020 0057 o072 ooog: 00 00 00 00 00 00 oo oo ...,
0010: 0069 0074 00 g ppmo 074 0068 0069 00i0: 00 00 00 00 00 00 00 00 .....
oola: 0073 0020 00 061 0020 0073 00ig: 00 00 00 00 00 3C 21 95 ... <
0020: 0074 0072 00  Ersse Al 826 OFBO 0720 0020 00 &0 00 00 00 91 00 OO0 ... ..
00Z2&: 0F55 0040 OF 092 1320 1340 0028.00 00 00 0O OO0 FO 27 96 ..... '
0030: 0320 0B20 03  Lock Device BAD 1F20 3440 0030: 00 §0 10 01 4F 7C E4 12 ....0]..
0028: 0001 0001 OOos orao olzo LEAD 1540 1520 0038 00 FC 27 96 00 8F 0A 01 oo
0040: 2542 0002 1440 1420 2846 0000 0720 0OF20 0040:.C3 34 E4 12 00 08 28 9% .4 [
oo04d: 00A0 0520 0D20 0SA0 1840 1820 1aA0 1420 004800 00 00 00 00 00 0o o0 ... .. -
0050: 1940 1920 1BAOD 1B20 1220 1240 1740 1720 0050: 00 14 28 96 00 00 0O OO0 { ..
0058 : 1FAQD 30A0 16A0 1620 3840 0220 02A0 OAZD oo05a. 00 00 00 00 00 20 28 96 {
O060: 1140 1120 10A0 1020 3CAOD 1D20 1DAOD 0420 00e0: 00 EO OO0 00 00 91 00 oo ... .. -
O068: 0440 0C20 2826 0000 0000 OFOO OCOO 2072 0065 00 2C 28 96 00 30 28 96 [T
oo70: 0000 0003 0000 OFO1 2077 0000 0920 0000 o070 00 DS 11 01 BA 38 28 96 ai
0078 0000 0000 0000 0000 0000 0000 o000 o000 0078: 00 3C 28 96 00 AS 10 01 . <f -
0080: 0000 0000 0000 0000 0000 0000 0000 0000 0080: F3 44 28 96 00 48 28 95 .D{. .H(.
008s: 0000 0000 0000 0000 0000 0000 o000 0000 oo&s: 00 00 00 00 00 50 28 96 Fi
0o0%0: 0000 0000 0000 0000 0000 0000 o000 ooono o090 00 54 28 96 00 00 OO0 OO0 .T¢ -
0098: 0000 0000 0000 0000 0000 0000 0000 0000 009800 00 00 0O 00 60 28 96 ..... {
0o0&0: 0000 0000 0000 0000 0000 0000 o000 0000 oo0A0: 00 0O OO0 00 00 00 00 00
00A4%: 0000 0000 0000 0000 0000 0000 o000 ooono 0048 00 &C 28 96 00 00 OO0 OO .1
00B0: 0000 0000 0000 0000 0000 0000 0000 0000 00BO: 00 91 00 00 00 50 00 00 ..... P..
0o0BS: 0000 0000 0000 0000 0000 0000 OO000 o000 00ES: 00 3C 21 95 00 3C 21 95 .ol <.
ooco: 0000 0000 0000 0000 0000 0000 o000 ooono ooco: 00 00 00 00 o0 00 oo oo ..., .
00CE: 0000 0000 0000 0000 0000 0000 0000 0000 00Ca: 00 00 00 00 00 00 00 00 .....
oopo: 0000 0000 0000 0000 0000 0000 o000 o000 oopo: 0o 00 00 00 00 00 0o oo ...,
oopE: 0000 0000 0000 0000 0000 0000 o000 o000 oops: 00 00 00 00 00 00 oo oo ... ..
O0ED: 0000 0000 0000 0000 0000 0000 0000 0000 O0ED: 00 00 00 00 00 00 00 00 .....
O0ES: 0000 0000 0000 0000 0000 0000 o000 o000 00ES: 00 00 00 00 00 00 0o oo ... ..
O0F0: 0000 0000 0000 0000 0000 0000 0000 0000 00F0: 00 00 00 00 00 00 00 00 .....
O0F&: 0000 0000 0000 0000 0000 0000 0000 0000 00F&. 00 00 00 00 00 3C 21 95 ..., <!
oloo: 0000 0000 0000 0000 0000 0000 OoO000 o000
Mina-nonn nnnn annn nann nnnn nnnn nnnn nnnn bl A8 >
Diownload progrem memory from MCU to PC HUK
Figure 5

Upload — Read

Before executing an upload command, the file to be uploaded must first be opened using the "File”
menu. Also select the MCU type required from "Select MCU Type”. See Figure 6.

Within the Upload function are three commands, "Program”, "EEData” and "ALL". Selecting the
"Program” command, will only read the Program Memory data. Selecting the "EEData” command
will only read the EEPROM Data Memory area. Selecting the "ALL” command, will read both the
Program Memory data and the EEPROM Data Memory data. See Figure 7.

The data that is read out will be displayed in the corresponding Windows. If it is required to save
the data, the "Save” command, located withing the "File” menu, can be used.
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H8txle - EverPro S1000

Edit ¥iew Upload Download Iools Help

td8fxlle - EverPro S1000

Open e P RP& 2
Save Program Memory ~ EEData Memory
Saveds 4 & 7 ADDR 0 1 2 3 4 5 £ 7
Close 3333 4444 5555 6RGE D074 D065 0000:00 00 00 00 00 00 00 00 ... ...
= 0069 006E 0067 0020 DOS7 0072 000%:00 00 00 00 00 00 00 00 ... ...
HisapeE | B26 0074 0068 0069 0010:00 00 00 00 00 00 00 00
°t 020 0061 0020 0073 0018:00 00 00 00 00 3C 21 95 ... .. <!
U 0c7 2626 0FR0 0720 0020:00 &0 00 00 00 91 00 00
HT40F30E  FRA 0092 1320 13&0 0023:00 00 00 00 00 FO 27 36 ‘
) = 0640 1F20 340 0030:00 90 10 01 4F 7C E4 12
Exit HT48FS0E  4op 1EAD 1540 1520 003&: 00 FC 27 96 00 BF 04 01
0040: 2842 0002 HT48FME  B46 0000 0720 OF20 0040:C3 34 E4 12 00 08 28 36 4. .. (.
0046 00A0 0520 uweu voao AN 1820 1240 1420 0046:00 00 00 00 00 00 00 00 o
0050: 1940 1920 1BA&D 1B20 1220 1240 1740 1720 0050000 14 28 96 00 00 00 00
0058: 1FAD 3040 16A0 1620 3340 0220 0240 0420 00S8:00 00 00 00 00 20 28 96
00601140 1120 10&0 1020 3CAQD 1D20 1DAD 0420 00&0: 00 EO 00 00 00 91 00 00
006G D440 0OC20 2826 0000 0000 OFO0 0CO0 2072 0063:00 2C 28 96 00 30 28 36
0070: 0000 0003 0000 OFOL 2077 0000 0920 0000 0070:00 DS 11 01 BA 38 20 36
00750000 0000 0000 0000 0000 0000 0000 0000 007&:00 3C 28 96 00 A5 10 01
0080: 0000 0000 0000 0000 0000 0000 0000 0000 0080:F3 44 28 96 00 48 28 96
0066: 0000 0000 0000 0000 0000 0000 0000 0000 008@: 00 00 00 00 00 50 28 96
0090: 0000 0000 0000 0000 0000 0000 0000 0000 0030:00 S4 28 96 00 00 00 OO
0098: 0000 0000 0000 0000 0000 0000 0O00 0000 009%:00 00 00 00 00 60 28 96
00A40° 0000 0000 0000 0000 0000 0000 0000 0000 00A0° 00 00 00 00 00 00 00 00
00AG: 0000 0000 0000 0000 0000 0000 0000 0000 00A%:00 6C 28 96 00 00 00 00 .1(...
00B0: 0000 0000 0000 0000 0000 0000 0000 0000 00D0: 00 91 00 00 00 50 00 00 ... .. P
00BG: 0000 0000 0000 0000 0000 0000 0000 0000 00B&:00 3C 21 95 00 3C 21 35 .<l..<|
00CO: 0000 0000 0000 0000 0000 0000 0000 0000 00CO: 00 00 00 00 00 00 00 00
00CE: 0000 0000 0000 0000 0000 0000 0000 0000 00C&: 00 00 00 00 00 00 00 OO
00D0: 0000 0000 0000 0000 0000 0000 0000 0000 00D0: 00 00 00 00 00 00 00 00
00DG: 0000 0000 0000 0000 0000 0000 0000 0000 00DG: 00 00 00 00 00 00 00 00 ... ...
00ED: 0000 0000 0000 0000 0000 0000 0000 0000 O0ED: 00 00 00 00 00 00 00 00
00ES: 0000 0000 0000 0000 0000 0000 0000 0000 O0ES: 00 00 00 00 00 00 00 00 ... ...
00F0: 0000 0000 0000 0000 0000 0000 0000 0000 00F0: 00 00 00 00 00 00 00 00
00FG: 0000 0000 0000 0000 0000 0000 0000 0000 00F:00 00 00 00 00 3C 21 3§
0100: 0000 0000 0000 0000 0000 0000 0000 0000
A1AR° NANA AAAA ARAR AARA AAAA ARAR AR Aann v [€
M
Figure 6

Fie Edit View Dpload
= & ‘ Pogiam s

P EEData ~ EEData Memory
abbe 0 1 I - ¢ ADDR 0 1 2 3 4 & & 7
0000: 1111 2222 33 666 0074 0065 000000 00 00 00 00 00 00 00 .. ...
0008: 0073 0074 00  ErseProgrem 020 0057 0072 0008 00 00 00 00 00 00 00 00 .....
0010: 0069 0074 00 g per (074 0068 DDEY 001000 00 00 00 00 00 00 00 .. ... .
0018:0073 0020 O 061 0020 0073 001000 00 00 00 00 3C 21 95 .. ... <l
0020:0074 0072 00  Erse 41 826 DFE0 0720 0020 00 &0 00 00 00 81 00 00 .. ... .
0028 : DFS5 OUA0 DF 092 1320 1340 002800 00 00 00 00 F0 27 96 '
00300320 0B20 03 LockDeviee 640 1F20 3420 003000 80 10 01 4F 7C E4 12 . .
0033: 0001 0001 O0us urau urzu 1EAD 1530 1520 0038 00 FC 27 96 00 BF DA 01 ..'.....
0040: 2842 0002 1440 1420 2346 0000 0720 OF20 D040 C3 34 E4 12 00 08 28 96 .4....(.
0045 D040 0520 OD20 0SAD 18A0 1820 1AA0 1420 D048 00 00 00 00 00 00 00 00 .. ... L
0050: 1340 1320 1BAD 1E20 1220 1240 1740 1720 005000 14 28 96 00 00 00 00 ..(.....
005%: 1FA0 3040 1640 1620 3340 0220 D2A0 DA20 005800 00 00 00 00 20 28 96 .. ... (.
00601140 1120 1040 1020 3CAD 1D20 1D&0 0420 D060 00 E0 00 00 00 91 00 00 .. ... .
0063: 0440 0C20 2826 0000 0000 OFO0 OCOO 2072 0065 00 2C 28 96 00 30 28 96 ., (..0(.
0070:0000 0003 0000 OF01 2077 0000 0920 0000 007000 DS 11 01 BA 33 28 96 ... .. 8(.
0075:0000 0000 0000 0000 0000 D000 D000 0000 0078 00 3C 2B 96 00 &5 10 01 .<(.....
00g0: 0000 0000 0000 0000 0000 0000 0000 0000 0080 F3 44 28 96 00 48 28 96 .D(..H(.
0022: 0000 0000 0000 0000 0000 D000 0000 0000 008200 00 00 00 00 50 28 96 .. ... F{.
00900000 0000 0000 0000 0000 D000 0000 0000 D090 00 54 28 96 00 00 00 00 o
0093:0000 0000 0000 0000 0000 0000 0000 0000 0098 00 00 00 00 00 &0 28 96 .. ... e
00&40: 0000 0000 0000 0000 0000 D000 D000 0000 D00 00 00 00 00 00 00 00 0O .. ... L
0030000 0000 0000 0000 0000 0000 D000 0000 0048 00 6C 28 96 00 00 00 00 .1¢
00B0: 0000 0000 0000 0000 0000 0000 0000 0000 00E0 00 91 00 00 00 50 00 00 ... .. F..
00B2: 0000 0000 0000 0000 0000 0000 D000 0000 DOBZ 00 3C 21 95 00 3C 21 95 .<l. . ¢!
00C0- 0000 0000 0000 0000 0000 0000 D000 0000 00CO 00 00 00 00 00 00 00 00
00C3: 0000 0000 0000 0000 0000 0000 0000 0000 00CE: 00 00 00 00 00 00 00 00 .. ...
00D0: 0000 0000 0000 0000 0000 0000 0000 0000 DOD0: 00 00 00 00 00 00 00 00 .. ...
00D 0000 0000 0000 0000 0000 0000 D000 0000 00D 00 00 00 00 00 00 00 00
00E0: 0000 0000 0000 0000 0000 0000 0000 0000 DOED: 00 00 00 00 00 00 00 00 .. ...
00EG: 0000 0000 0000 0000 0000 0000 0000 0000 DOEG: 00 00 00 00 00 00 00 00 .. ...
00F0: 0000 0000 0000 0000 0000 0000 D000 0000 00F0- 00 00 00 00 00 00 00 00
00F: 0000 0000 0000 0000 0000 0000 0000 0000 00FE: 00 00 00 00 00 3C 21 95 ..... <l
0100:0000 0000 0000 0000 0000 0000 D000 0000
fing-AAAR AR OARR AARR ARAR ARG NAAR nnn )|
Diownload program snd EEData memory from MCT to PC UK

Figure 7
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Verify Program

The "Verify Program”, "Verify EEData” and "Verify All” commands, within the Upload menu, can
be used to verify the Program and EEPROM Data Memory. The required *.MTP file must first be
opened before any of these operations are carried out. See Figure 8.

t48fxlle - EverPro S1000

File Edit View Upload Tools Help
Py = 1 Brogem e
P EEDan A EEData Memory

A0DR 0O 1 2 3 4 5 & 7

oooo: 00 00 00 00 0o o0 o000 ...,

ooos: 00 00 00 00 00 00 oo oo ... ...
0010: 0069 0074 00 g ' rrmam 074 0D06E 0069 oo0i0:00 00 00 00 00 00 00 00 .......
0o018: 0073 0020 00 061 0020 0073 oo0ils: 00 00 00 00 OO0 3C 21 95 <!
0020: 0074 0072 00  Erse Al 826 OF20 0720 oo0z2o: 00 A0 00 00 OO 91 0O OO0 .......
0029: OF55 0040 OF 092 1320 1340 0028:00 00 00 00 OO0 FO 27 96 ...... !
0030: 0320 0B20 03 LockDevice BA0 1F20 3440 oo030: 00 80 10 01 4F 7C E4 12 [u]]
0038: 0001 0001 O0os oraoc uleu LEAD 1540 1520 0038: 00 FC 27 96 00 8F 04 01
0040: 2642 0002 1440 1420 2846 0000 0720 0OF20 0040:C3 34 E4 12 00 08 28 96 4 {
0048: 0040 0520 0D20 OSA0 18A0 1820 1440 1420 oo4s: 00 00 00 00 OO OO0 00 OO0
O050: 1940 1920 1BAQ 1E20 1220 1240 1740 1720 oo0so: 00 14 28 96 00 00 00 OO0 [
0058: 1FAD 3040 1eA0 1620 3840 0220 0240 0420 0058:00 00 00 00 OO0 20 28 96 {
O0A0: 1140 1120 10A0 1020 3CAD 1D20 1DAOD 0420 oos0: 00 E0 00 00 00 91 00 OO0
O069: 0440 0C20 2826 0000 0000 OFOO0 OCOO0 2072 0068 00 2C 28 96 00 30 28 96 [
0070: 0000 0003 0000 OFO01 2077 0000 0920 0000 0070:00 D5 11 01 B 38 28 96 a1
0078: 0000 0000 0000 0000 OOO0 0000 0000 0000 0078:00 3C 28 96 00 AS 10 01 . «<f
oo80: 0000 0000 0000 0000 0000 0000 o000 o000 0080:F3 44 28 96 00 48 28 96 D Hi
o08g: 0000 0000 0000 0000 0000 0000 o000 ooono oogs: 00 00 00 00 OO0 50 28 96 Fi
009%0: 0000 0000 0000 0000 0OO00 0000 0000 0000 0090: 00 54 28 96 00 00 0O OO0 . T¢
0098: 0000 0000 0000 0000 0000 o000 o000 o000 0098: 00 00 00 00 00 &0 28 96 [
O0AD: 0000 0000 0000 0000 0000 o000 oO0O00 ooono o0Aa0: 00 00 00 00 OO OO0 OO oo .......
00&48: 0000 0000 0000 0000 OOOQ OO0OO0 0000 0000 0048:00 6C 268 96 00 00 0O OO0 . 1¢
OO0EO: 0000 0000 0000 0000 0000 0000 0000 0000 oo0E0: 00 91 00 00 00 50 00 00
OOES: 0000 0000 0000 0000 0000 0000 o000 ooon 00ES: 00 3C 21 95 00 3C 21 95 ¢l ¢!
00CO: 0000 0000 0000 0000 0O00 0000 0000 0000 0oco: 00 00 00 00 00 00 00 00 .......
O00ca: 0000 0000 0000 0000 0000 0000 o000 0000 oocs: 00 00 00 00 00 00 00 o0
00D0: 0000 0000 0000 0000 0000 o000 oO0O00 ooono oopo: 00 00 00 00 00 o0 oo oo ... ...
00Ddg: 0000 0000 0000 0000 0O00 0000 0000 0000 00DE: 00 00 00 00 00 00 00 00 .......
O0E0: 0000 0000 0000 0000 0000 0000 0000 0000 0o0EOD: 00 00 00 00 00 OO0 00 o0
OO0ES: 0000 0000 0000 0000 0000 0000 o000 o000 00ES: 00 00 00 00 00 00 o0 oo .......
00F0: 0000 0000 0000 0000 0O00 0000 0000 0000 OO0F0: 00 00 00 00 00 00 00 00 .......
00F3: 0000 0000 0000 0000 0000 0000 0000 0000 00Fs: 00 00 00 00 00 3C 21 95 <!
0100: 0000 0000 0000 0000 0000 o000 o000 o000
mna-nnnn nonn nnnn annn annn nnan nnnn nnnn healll 8 >
Eras Promgram memory NUK

Figure 8
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Device Lock

After the device has been programmed, if it is required to protect the programmed data, then
"Lock Device” within the "Download” menu can be selected . After this operation has been exe-
cuted it will not be possible to read back the source program within the MCU.

See Figure 9.

t48fxlle - EverPro S1000

File Edit ¥iew Upload [l Tools Help
Py = 1 Bogem K
P EEDan A EEData Memory
ADDR o 1 | ALL ) £ 7 ADDE 0 1 2 3 4 5 & 7
oooog: 1111 2222 33 BEGE 0074 006G oooo: 00 00 00 00 00 o0 o0 o0 ...,
0008: 0073 0074 00 Erase Program 020 0057 0072 oo0&: 00 00 00 00 00 00 00 00 .......
0010: 0069 0074 00 g oo een 074 0D06E 0069 oo0i0:00 00 00 00 00 00 00 00 .......
0018: 0073 0020 00 06l 0020 0073 oo0la: 00 00 00 00 0o 3C 21 9% cooaad
0020: 0074 0072 00  Ersse Al 826 OF20 0720 o020: 00 &0 00 00 OO 91 0O OO0 .......
0025: 0F55 0040 OF 092 1320 1340 002&:00 00 00 00 OO0 FO 27 96 ...... !
oo030: 0320 0B20 03 BAD 1F20 3440 0030: 00 80 10 01 4F 7C E4 12 ]|
0039: 0001 0001 000S Uraoc olezu LEAD 1540 1520 o038: 00 FC 27 96 00 8F 04 01
0040: 2642 0002 1440 1420 2846 0000 0720 0OF20 0040:C3 34 E4 12 00 08 28 96 . 4....(
0048: 0040 0520 0D20 OSA0 18A0 1820 1440 1420 ood4s: 00 00 00 00 OO OO0 00 OO0
O050: 1940 1920 1BAQ 1E20 1220 1240 1740 1720 oo0so: 00 14 28 96 00 00 0O OO0 b
0059: 1FAD 3040 1640 1620 3840 0220 0240 0A20 0058:00 00 00 00 OO0 20 28 96 .....
O0A0: 1140 1120 1040 1020 3CAD 1D20 1DAOD 0420 oos0: 00 E0 00 00 00 91 00 OO0
O069: 0440 0C20 2826 0000 0000 OFOO OCOO 2072 00e8: 00 2C 28 96 00 30 28 9 ., (..0(
0070: 0000 0003 0000 OFO01 2077 0000 0920 0000 0070:00 D5 11 01 Ba 38 28 96 ... .8(
0o078: 0000 0000 0000 0000 OOO0O 0000 QOO0 0000 o078:00 3C 28 96 00 AS 10 01 «f
oo080: 0000 0000 0000 0000 0000 o000 o000 o000 0080:F3 44 28 96 00 48 28 96 . D{. H{
0085: 0000 0000 0000 0000 OOO0 OO0OO0 0000 0000 0088:00 00 00 00 OO0 50 28 96 .....P{
oo090: 0000 0000 0000 0000 0000 0000 QOO0 0000 oo90: 00 54 28 96 00 00 00 OO . T¢
0098: 0000 0000 0000 0000 0000 o000 o000 o000 o098: 00 00 00 00 00 e0 28 96 R
00&0: 0000 0000 0000 0000 0OO00 0000 0000 0000 0040: 00 00 00 00 00 00 00 00 .......
00&45: 0000 0000 0000 0000 OOOQ OOOO 0000 0000 0048:00 6C 28 96 00 00 00 OO0 .1¢(....
OOEO: 0000 0000 0000 0000 0000 0000 o000 o000 00E0: 00 91 00 00 00 S0 00 00 T =
OOES: 0000 0000 0000 0000 0000 0000 o000 ooon 00ES: 00 3C 21 95 00 3C 21 95 ¢l . ¢!
00CO: 0000 0000 0000 0000 0O00 0000 0000 0000 0oco: o0 00 00 00 00 00 00 00 .......
00Cg: 0000 0000 0000 0000 0000 o000 o000 o000 ooce: 00 00 00 00 00 00 oo oo ...,
00D0: 0000 0000 0000 0000 0000 o000 oO0O00 ooono oopo: 00 00 00 00 00 o0 oo oo ... ...
00Ddg: 0000 0000 0000 0000 0O00 0000 0000 0000 00DE: 00 00 00 00 00 00 00 00 .......
O0E0: 0000 0000 0000 0000 0000 0000 0000 0000 0o0EOD: 00 00 00 00 00 OO0 00 OO0
O0ES: 0000 0000 0000 0000 0000 0000 o000 o000 00Es: 00 00 00 00 OO OO0 0o oo o......
00F0: 0000 0000 0000 0000 0O00 0000 0000 0000 00F0: 00 00 00 00 00 00 00 00 .......
O0F3: 0000 0000 0000 0000 0000 0000 0000 0000 00Fs: 00 00 00 00 00 3C 21 95 <!
0100: 0000 0000 0000 0000 0000 0000 OoO0oO0 ooono
Mna-nnnn nonn annn annn annn nnan nnnn nnnn halll 59 b
Lock program and data in M TP chip N
Figure 9

10



HOLTEK Holtek EIC-100 User's Guide

Erase

If it is required to update the program within the MCU, but if the data in the MCU has been pro-
tected, which prevents reading, the MCU should first be erased.

The "Erase” command is located within the download menu. When erasing the MCU data, itis rec-
ommended that the "Erase All” function is used. If the MCU was unlocked during the update opera-
tion, then there is no need to first erase the MCU. Programming can be carried out directly as
shown in Figure 10.

t48fxlle - EverPro S1000

P EEDsw A EEData Memorv
ADDR ALL ) ADDR 0O 1 2 3 4 5 & 7
oono: 1111 2222 33 L66 0074 0065 O00oo: 00 00 00 00 00 00 0O 00 .......
O0008: 0073 0074 00 Erase Frogram 020 0057 0072 ooos: 00 00 00 00 00 OO0 00 o0
oolo: 00 00 00 00 00 o0 o0 o0 ...,
001&:00 00 00 00 OO0 3C 21 95 <!

00F0: 0000 0000 0000 0000 0000 0000 0000 0000 00FD: 00 00 00 00 00 00 00 00 .. .....

O0Fg: 0000 0000 0000 0000 0000 0000 0000 0000 O0F2: 00 00 00 00 O0 3C 21 9% ... <!

01i00: o000 0000 0000 0000 0000 Oo000 0000 0000

Mina- nann nann nonn nnnn annn nnnn onon nnnn ol B td

Eraz Promgram and EEData memornye NI
Figure 10

11
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Reset

The "Reset" command is located within the "Tools” menu and is used to reset the MCU condition.

If the device is in the "Auto Power On” condition, executing the "Reset” command will force the
MCU to return to its initial condition and restart its program. If the device is in the "power on” state,
executing the "Reset” command may place the MCU in a "power down” state, requiring the execu-
tion of a "power on” command for the MCU to restart operation. See Figure 11.

td8fxlle - EverPro S1000

File Edit ¥iew UDpload Download BEEES Help
= & Tp fo | Jj_ v Option

Program } -~ EEData Memory
ADDE 1 1 2 3 7 A0DE 0 1 2 2 4 5 & 7
0000: 1111 2222 3333 4444| RowerOn 00gs oooo: o0 00 00 00 o0 o0 o0 o0 ...
0o08: 0073 0074 0069 O0DGE| * Power Off 007z 0oo0&: 00 00 00 00 o0 o0 o0 o0 ...
O010: 0069 0074 0065 Q072 00e9 0010:00 00 00 00 OO0 00 0O OO0 .......
0019: 0073 0020 0069 0073 v Auto Power On 0073 0018:00 00 00 00 00 2C 21 95 ... .l
0020:0074 0072 0069 ODGE'vourcoco—wrou 0720 0020: 00 A0 00 00 00 91 o0 o0 .......
0023: 0F55 00AQ OF02 O0A1 OFAA 0092 1320 1340 002%:00 00 00 00 OO0 FO 27 96 ......
0030: 0320 0B20 0340 0620 OE20 O6AD 1F20 34A0 0030:00 80 10 01 4F 7C E4 12 4]
0038: 0001 0001 0005 01A0 0120 1EAD 1540 1520 003800 FC 27 96 00 8F 04 01 !
O040: 2842 0002 1440 1420 2846 0000 0720 OFZ0 0040:C3 34 E4 12 00 08 28 96 .4 [
0048: 00AD 0520 0D20 05AD 1840 1820 1AAD 1AZ0 0048:00 00 00 OO0 OO OO QO OO .......
0050: 1940 1920 1BAD 1B20 1220 1240 1740 1720 0050:00 14 28 96 00 00 00 00 {
O0058: 1FAD 3040 16A0 1620 3840 0220 0240 0AZO O005&: 00 00 00 00 OO0 20 28 96 [
006D: 11A0 1120 1040 1020 3CAD 1D20 1DAD 0420 00e0: 00 E0 0O 00 OO 91 0O 00 .......
O068: 0440 0C20 2826 0000 0000 OFOO OCOO 2072 006800 2C 28 96 00 30 28 94 (.08
O070: 0000 0003 0000 OF01 2077 0000 0920 0000 O0070:00 DS 11 01 Ba 38 28 96 ai
0078:0000 0000 0000 QOO0 Q00O 0OOD OOO00 o000 0078:00 3C 28 96 00 A5 10 01 «f
Qog0: o000 0000 0000 0000 0000 o000 0000 0000 O0080:F3 44 28 96 00 48 28 96 . D{. H{
O088: 0000 0000 0000 OOO0O 0000 0000 O000 o000 O008&: 00 00 00 00 OO0 50 28 96 P
00%0: 0000 0000 0000 QOO0 Q00O 0OO0D OO00 oo0o 00%0:00 54 28 96 00 00 0O 00 . T¢
0098: 0000 0000 0000 0000 0000 o000 0000 0000 009200 00 00 00 00 60 28 96 {
O0AD: 0000 0000 0000 0000 0000 o000 0000 0000 O00A0: 00 00 00 00 00 o0 o0 o0 ... ...
O0&8: 0000 0000 0000 OOOO Q00O 0O0D OOO00 o000 004%:00 6C 28 96 00 00 0O 00 1%
ODED: 0000 QOO0 0OOO QOOO Q000D 0000 OO00 Oooo 00EB0: 00 91 00 00 OO 50 0O 00
O0ES: 0000 0000 0000 0000 0000 o000 0000 0000 O0BE&: 00 3C 21 95 00 3C 21 9% <!, <!
O0Co: 0000 0000 0000 QOO0 Q000 0000 OO00 o000 00C0: 00 00 00 00 00 00 0O OO0 .......
00C8: 0000 0000 0OOO QOOO Q000D 0000 OOO00 Oooo 00Cg: 00 00 00 00 OO OO0 0O OO0 .......
0opoD: o000 0000 0000 0000 0000 Oo000 0000 0000 0opo: 00 00 00 00 o0 o0 o0 o0 ...
O0DE: 0000 0000 0000 OOO0O 0000 0000 o000 o000 O00D&E: 00 00 00 00 OO0 o0 00 oo
ODED: 0000 0000 0OOO QOO0 Q0000 0000 OO00 oooo O0ED: 00 00 00 00 OO OO0 0O OO0 .......
OOES: 0000 0000 0000 0000 0000 o000 0000 0000 O0ES: 00 00 00 00 o0 o0 o0 o0 ..., ..
O0FD: 0000 0000 0000 OOO0O 0000 0000 o000 o000 O0F0: 00 00 00 00 OO0 o0 00 oo
O0F8: 0000 0000 0OOO QOOO Q00O 0000 OOO00 Oooo 00Fg: 00 00 00 00 OO 3C 21 95 ... ¢!
0100: o000 0000 0000 0000 0000 o000 0000 0000
Mna-nnnn nonn nnnn annn annn nnan nnnn nnnn bl £ *
Reset Starter Kit NUR
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